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Preface

Preface

Thank you for purchasing this Topcon product. The materials
available in this Manual (the “Manual”) have been prepared by
Topcon Positioning Systems, Inc. (“TPS”) for owners of Topcon
products, and is designed to assist owners with the use of the receiver
and its use is subject to these terms and conditions (the “Terms and
Conditions”).

@ NOTICE

Please read these Terms and Conditions carefully.

Terms and Conditions

PROFESSIONAL USE - This product is designed to be used by a
professional. The user is required to be a professional surveyor or
have a good knowledge of surveying, in order to understand the user
and safety instructions, before operating, inspecting or adjusting.
Always wear required safety attire (safety shoes, hard hat, etc.) when
operating.

COPYRIGHT - All information contained in this Manual is the
intellectual property of, and copyrighted material of TPS. All rights
are reserved. You may not use, access, copy, store, display, create
derivative works of, sell, modify, publish, distribute, or allow any
third party access to, any graphics, content, information or data in this
Manual without TPS’ express written consent and may only use such
information for the care and operation of your receiver. The
information and data in this Manual are a valuable asset of TPS and
are developed by the expenditure of considerable work, time and
money, and are the result of original selection, coordination and
arrangement by TPS.
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TRADEMARKS - Topcon Tools™, TopSURV™, Modem-TPS™,
HiPer®, Topcon® and Topcon Positioning Systems™ are trademarks
or registered trademarks of TPS. Windows® is a registered trademark
of Microsoft Corporation. The Bluetooth® word mark and logos are
owned by Bluetooth SIG, Inc. and any use of such marks by Topcon
Positioning Systems, Inc. used under license.

DISCLAIMER OF WARRANTY - EXCEPT FOR ANY
WARRANTIES IN AN APPENDIX OR A WARRANTY CARD
ACCOMPANYING THE PRODUCT, THIS MANUAL AND THE
RECEIVER ARE PROVIDED “AS-IS.” THERE ARE NO OTHER
WARRANTIES. TPS DISCLAIMS ANY IMPLIED WARRANTY
OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR
USE OR PURPOSE. TPS AND ITS DISTRIBUTORS SHALL NOT
BE LIABLE FOR TECHNICAL OR EDITORIAL ERRORS OR
OMISSIONS CONTAINED HEREIN; NOR FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES RESULTING FROM THE
FURNISHING, PERFORMANCE OR USE OF THIS MATERIAL
OR THE RECEIVER. SUCH DISCLAIMED DAMAGES
INCLUDE BUT ARE NOT LIMITED TO LOSS OF TIME, LOSS
OR DESTRUCTION OF DATA, LOSS OF PROFIT, SAVINGS OR
REVENUE, OR LOSS OF THE PRODUCT’S USE. IN ADDITION
TPS IS NOT RESPONSIBLE OR LIABLE FOR DAMAGES OR
COSTS INCURRED IN CONNECTION WITH OBTAINING
SUBSTITUTE PRODUCTS OR SOFTWARE, CLAIMS BY
OTHERS, INCONVENIENCE, OR ANY OTHER COSTS. IN ANY
EVENT, TPS SHALL HAVE NO LIABILITY FOR DAMAGES OR
OTHERWISE TO YOU OR ANY OTHER PERSON OR ENTITY
IN EXCESS OF THE PURCHASE PRICE FOR THE RECEIVER.

LICENSE AGREEMENT - Use of any computer programs or
software supplied by TPS or downloaded from a TPS website (the
“Software”) in connection with the receiver constitutes acceptance of
these Terms and Conditions in this Manual and an agreement to abide
by these Terms and Conditions. The user is granted a personal, non-
exclusive, non-transferable license to use such Software under the
terms stated herein and in any case only with a single receiver or
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Terms and Conditions

single computer. You may not assign or transfer the Software or this
license without the express written consent of TPS. This license is
effective until terminated. You may terminate the license at any time
by destroying the Software and Manual. TPS may terminate the
license if you fail to comply with any of the Terms or Conditions. You
agree to destroy the Software and manual upon termination of your
use of the receiver. All ownership, copyright and other intellectual
property rights in and to the Software belong to TPS. If these license
terms are not acceptable, return any unused software and manual.

CONFIDENTIALITY - This Manual, its contents and the Software
(collectively, the “Confidential Information”) are the confidential and
proprietary information of TPS. You agree to treat TPS’ Confidential
Information with a degree of care no less stringent that the degree of
care you would use in safeguarding your own most valuable trade
secrets. Nothing in this paragraph shall restrict you from disclosing
Confidential Information to your employees as may be necessary or
appropriate to operate or care for the receiver. Such employees must
also keep the Confidentiality Information confidential. In the event you
become legally compelled to disclose any of the Confidential
Information, you shall give TPS immediate notice so that it may seek a
protective order or other appropriate remedy.

WEBSITE; OTHER STATEMENTS - No statement contained at
the TPS website (or any other website) or in any other advertisements
or TPS literature or made by an employee or independent contractor
of TPS modifies these Terms and Conditions (including the Software
license, warranty and limitation of liability).

SAFETY - Improper use of the receiver can lead to injury to persons
or property and/or malfunction of the product. The receiver should
only be repaired by authorized TPS warranty service centers. Users
should review and heed the safety warnings in an Appendix.
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MISCELLANEOUS - The above Terms and Conditions may be
amended, modified, superseded, or canceled, at any time by TPS. The
above Terms and Conditions will be governed by, and construed in
accordance with, the laws of the State of California, without reference
to conflict of laws.

Regulatory Information

The following sections provide information on this product’s
compliance with government regulations.

FCC Class B Compliance

This device complies with Part 15 of the FCC rules. Operation is
subject to the following two conditions:

1. This device may not cause harmful interference, and

2. This device must accept any interference received, including
interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits
for a Class B digital device, pursuant to Part 15 of the FCC rules.
These limits are designed to provide reasonable protection against
harmful interference in residential installations. This equipment
generates, uses, and can radiate radio frequency energy, and if not
installed and used in accordance with the instructions, may cause
harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation.

If this equipment does cause interference to radio or television
equipment reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

» Reorient or relocate the receiving antenna.
* Move the equipment away from the receiver.

* Plug the equipment into an outlet on a circuit different from that
to which the receiver is powered.
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Manual Conventions

* Consult the dealer or an experienced radio/television technician
for additional suggestions.

@ CAUTION

Any changes or modifications to the equipment not
expressly approved by the party responsible for
compliance could void your authority to operate such
equipment.

Canadian Emissions Labeling
Requirements

This Class B digital apparatus meets all requirements of the Canadian
Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du
Réglement sur le matériel brouilleur du Canada.

Manual Conventions

This manual uses the following conventions:
Example Description

File » Exit Click the File menu and click Exit.
Connection Indicates the name of a dialog box or screen.

Frequency Indicates a field on a dialog box or screen, or a tab
within a dialog box or screen.

Enter Press or click the button or key labeled Enter.

Supplementary information that can help you configure,
maintain, or set up a system.
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@ NOTICE

Supplementary information that can have an affect on
system operation, system performance, measurements, or
personal safety.

@ CAUTION

Notification that an action has the potential to
adversely affect system operation, system
performance, data integrity, personal health.

), WARNING

[WARNI

Notification that an action will result in system damage,
loss of data, loss of warranty, or personal injury.

@ DANGER

UNDER NO CIRCUMSTANCES SHOULD THIS ACTION BE
PERFORMED.
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Chapter 1

Introduction

This chapter describes:
* The HiPer® XT receiver (Figure 1-1)
* GPS and your receiver
* Common receiver functions
 Standard package contents and configurations
* Receiver components
* The Option Authorization File (OAF)

Figure 1-1. HiPer XT Receiver
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Introduction

Overview

Topcon Positioning System’s HiPer XT is a dual-frequency, GPS+
receiver built to be the most advanced and compact receiver for the
surveying market. The HiPer XT is a multi-function, multi-purpose
receiver intended for precision markets. Precision markets means
markets for equipment, subsystems, components and software for
surveying, construction, commercial mapping, civil engineering,
precision agriculture and land-based construction and agriculture
machine control, photogrammetry mapping, hydrographic and any
use reasonably related to the foregoing.

The HiPer XT can receive and process both L1 and L2 signals,
improving the accuracy of your survey points and positions. The dual-
frequency and GPS+ features of HiPer XT combine to provide a real
time kinematic (RTK) system accurate for short and long baselines.
Several other features, including multipath mitigation and co-op
tracking, provide under-canopy and low signal strength reception.
The receiver provides the functionality, accuracy, availability, and
integrity needed for fast and easy data collection.

Principles of Operation

Surveying with the right GPS receiver can provide users accurate and
precise positioning, a requirement for any surveying project.

This section gives an overview of GPS and receiver functions to help
you understand and apply GPS principles, allowing you to get the
most out of your receiver.

GPS Overview

The Global Positioning System (GPS) is a satellite-based, line-of-
sight radio navigation system run by the United States Department of
Defense (DoD). This system offers a global, all weather, 24-hour
positioning, velocity, and time service to any user equipped with a
GPS tracking receiver, who is on or near the Earth’s surface. The
Global Navigation Satellite System (GLONASS), is the Russian
Federation Ministry of Defense counterpart to GPS.

1-2 HiPer XT Operator's Manual



Principles of Operation

For information on the current status of the GPS constellation, visit
http://tycho.usno.navy.mil/ or http://www.navcen.uscg.gov/. For
GLONASS, visit http://www.glonass-center.ru/frame.html.

Despite numerous technical differences in the implementation of
these systems, both GPS and GLONASS have three essential
components:

» Space — GPS and GLONASS satellites orbiting approximately
12,000 nautical miles above Earth and are equipped with a clock
and radio. These satellites broadcast digital information
(ephemerides, almanacs, time&frequency corrections, etc.).

* Control — Ground stations located around the Earth that monitor
the satellites and upload data, including clock corrections and
new ephemerides (satellite positions as a function of time), to
ensure the satellites transmit data properly.

* User — The community and military that use GPS/GLONASS
receivers and the corresponding satellites to calculate positions.

Calculating Positions

Once the receiver locks on to a satellite, it starts recording
measurements and receiving the various digital information
(ephemerides, almanac, and so on) the satellites broadcast. To
calculate a position, receivers use the following formula:

Velocity x Time = Distance

Where Velocity is the speed at which radio waves travel (i.e., the
speed of light) and Time is the difference between the signal
transmission time and signal reception time.

To calculate absolute 3-D positions—Ilatitude, longitude, altitude—
the receiver must lock on to four satellites. In a mixed, GPS and
GLONASS scenario, receiver’s must lock onto at least five satellites
to obtain an absolute position.

To provide fault tolerance using only GPS or only GLONASS, the
receiver must lock onto a fifth satellite. Six satellites will provide
fault tolerance in mixed scenarios.
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Once locked on to a satellite, the receiver collects ephemerides and
almanacs, saving this information to its NVRAM (Non-Volatile
RAM).

* GPS and GLONASS satellites broadcast ephemeris data
cyclically, with a period of 30 seconds.

» GPS satellites broadcast almanac data cyclically with a period of
12.5 minutes; GLONASS satellites broadcast almanac data
cyclically with a period of 2.5 minutes.

GPS Positioning
Achieving quality position results requires the following elements:

* Accuracy — The accuracy of a position primarily depends upon
the satellite geometry (Geometric Dilution of Precision, or
GDOP) and the measurement (ranging) errors.

— Differential positioning (DGPS and RTK) strongly mitigates
atmospheric and orbital errors, and counteracts anti-spoofing
signals the US Department of Defense transmits with GPS
signals.

— The more satellites in view, the stronger the signal, the lower
the DOP number, the higher positioning accuracy.

* Availability — The availability of satellites affects the calculation
of valid positions. The more visible satellites available, the more
valid and accurate the position. Natural and man-made objects
can block, interrupt, and distort signals, lowering the number of
available satellites and adversely affecting signal reception.

* Integrity — Fault tolerance allows a position to have greater
integrity, increasing accuracy. Several factors combine to provide
fault tolerance, including:

— Receiver Autonomous Integrity Monitoring (RAIM) detects
faulty GPS and GLONASS satellites and removes them from
the position calculation.

— Five or more visible satellites for only GPS or only
GLONASS:; six or more satellites for mixed scenarios.
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— Wide Area Augmentation Systems (WAAS, EGNOS, etc.)
creates and transmit, along with DGPS corrections, data
integrity information (for example, satellite health warnings).

— Current ephemerides and almanacs.

Conclusion

This overview simply outlines the basics of GPS and GLONASS
positioning. For more detailed information, visit the TPS website
(www.topconps.com/gpstutorial/).

Receiver Overview

When power is turned on and the receiver self-test completes, the
receiver’s 20 channels initialize and begin tracking visible GPS
satellites. Each of the receiver’s channels can be used to track C/A-
L1, P-L1, or P-L2 signals. The number of channels available allows
the receiver to track all visible GPS satellites at any time and location.

An internal GPS antenna equipped with a low noise amplifier (LNA)
and the receiver’s radio frequency (RF) device are connected with a
coaxial cable. The wide-band signal received is down-converted,
filtered, digitized, and assigned to different channels. The receiver
processor controls the process of signal tracking.

Once the signal is locked in the channel, it is demodulated and
necessary signal parameters (carrier and code phases) are measured.
Also, broadcast navigation data are retrieved from the navigation
frame.

After the receiver locks on to four or more satellites, it is possible to
solve the so-called “absolute positioning problem” and compute the
receiver’s coordinates (in WGS-84) and the time offset between the
receiver clock and GPS time. All this information is stored in the
receiver’s memory, which can be downloaded later onto a computer
and processed using a post-processing software package. When the
receiver is run in RTK mode, raw data measurements can also be
recorded into the receiver’s internal memory. This allows the operator
to double check real-time results obtained in the field.
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Depending on your options, capabilities of the receiver include:
* Co-Op Tracking
* Multipath reduction
* Wide area augmentation system (WAAS)

* Adjustable phase locked loop (PLL) and delay lock loop (DLL)
parameters

* Dual-frequency static, kinematic, real-time kinematic (RTK), and
differential GPS (DGPS) survey modes

* Auto data logging
* Setting different mask angles
* Setting different survey parameters

* Static or dynamic modes

Standard Package Contents

The HiPer XT comes in either a base or real-time kinematic (RTK)
package (also, refer to the packaging instruction card). The contents
of this package include:

* One HiPer XT receiver and one Legacy-E+, GB-500, or GB-1000
receiver

OR
Two HiPer XT receivers
* LitePole
* Tripod, tribrach, and adapter
» Topcon Tools™ software (optional)
* Cables, connectors, and adapters

e Literature
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Cables

Standard cables (Figure 1-2) can include the following:

Receiver-to-computer RS232 serial cable (p/n 14-008005-03) —
connects the receiver’s serial port and an external device (hand-
held controller or computer)

Receiver-to-SAE power cable (p/n 14-008016-03) — connects the
receiver’s power port and the power supply’s SAE connector or
the extension cable’s SAE connector

SAE-to-SAE cable extension (p/n 14-008022-01) — connects
SAE connectors over longer distances

Alligator clips-to-SAE cable (p/n 14-008025-01) — connects any
12-volt DC power source and the Receiver-to-SAE power cable

Power supply-to-outlet cable (p/n 14-008052-01 for U.S. or 14-
008054-01 for E.U.) — connects the power charger to a power
outlet

USB cable (p/n 14-008031-01) — connects the receiver and an
external device (hand-held controller or computer) via the USB
ports

Serial Receiver Pwr-to-SAE Antenna

OO
PAVES

Alligator clip-to-SAE
Figure 1-2. System Cables
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Power Supply/Charger

The Power Supply/Charger unit (p/n 22-034101-01) is used to charge
the internal batteries when connected to a grounded outlet; it can also
be used as an external power source (Figure 1-3). This unit converts
the alternating current (AC) normally supplied from an electrical
outlet to a direct current (DC) used to charge the batteries and power
the receiver.

* input voltage — between 100 and 240 V AC
* frequency of input power — between 50 Hz and 60 Hz
* output voltage — 12 V DC@2.5 A (30 W)

Figure 1-3. Power Supply/Charger

Software

Standard receiver software includes:

¢ PC-CDU - controller software that can run on a Windows®-
based computer.

* FLoader — Topcon’s firmware loader; available on the Topcon
website.

* BTCONF — Topcon’s Bluetooth® wireless technology module
configuration program; available on the Topcon website.

* Modem-TPS — Topcon’s radio modem configuration software;
available on the Topcon website.

* Topcon Tools — optional; Topcon’s post-processing software.

1-8 HiPer XT Operator's Manual



Standard Package Contents

Software and software information are also available on the Topcon
website (www.topcongps.com/software/index.html or http://
www.topcongps.com/software/3rdparty.html).

The following software will also be useful for operating, caring for
and using your receiver, and may be required for some applications.

* TopSURYV — Topcon’s field data collection software; among many
other functions, can be used to configure the radio/modem.

* Carlson SurvCE — optional third-party software for data
collection; contact your TPS dealer.

Literature

Receiver literature includes:
* One year warranty card
* HiPer XT Operator’s Manual
» Functional specifications
* Packaging instruction card

Manuals and other product information are also available on the
Topcon website—www.topcongps.com/support/manuals.html or
www.topcongps.com/hardware/index.html (then click on the
appropriate product).

The following manuals will also be useful for operating and caring for
your receiver. These are also available on the Topcon website
(www.topcongps.com/support/manuals.html).

* PC-CDU User’s Manual
» FLoader User’s Manual
* BTCONF User’s Manual
* Modem-TPS User’s Manual
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Getting Acquainted

The HiPer XT receiver is 158.5mm wide, 173mm deep, 113mm high,
and weighs approximately ??kg. The receiver’s advanced design
allows users to significantly reduce the number of cables required for
receiver operation, with the ability to perform jobs more reliably and
efficiently, especially when moving.

The receiver is also versatile and can be configured in several
different ways. The casing allocates space for two nonremovable, on-
board Li-Ion batteries, a Bluetooth wireless technology module, a
GSM communication module (optional), and two Euro cards. One of
the Euro cards is the GPS receiver and the other is used for UHF
communications.

See Table 1-2 on page 1-13 for a description of the operating times
for the HiPer XT receiver as a Base or Rover. For receiver
specifications, see Appendix A.

Internal Components

The following sections describe the internal components of the HiPer
XT receiver.

GPS+ Antenna

An internal, micro-strip antenna capable of receiving GPS L1/L.2
signals and GLONASS L1/L2 signals.

Bluetooth Module

A combination of software and hardware technology that makes the
HiPer XT a mobile, wireless, GPS+ receiver that support a point-to-
point serial profile. As such, the HiPer XT can transfer and
synchronize files between the receiver and any other Bluetooth
wireless technology device that supports serial profile, including
portable handheld devices and external controllers, Bluetooth
adapters for PC-USB/RS ports, mobile computers and phones, IPAQs,
PCMCA-to-Bluetooth adapters, etc.
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With Bluetooth wireless technology, the receiver’s reception and
transmission distance is 10 meters (32 feet) for interior projects and
30-50 meters (98—164 feet) for exterior projects.

The Bluetooth module’s processor and firmware are independent of
the receiver card and power board.

Radio Modem

The receiver incorporates an internal, TPS UHF transmitter/receiver
at 20MHz bandwidth, with a 12.5/25kHz channel spacing, and a
maximum 2W power output for data transmission. The Base station’s
modem transmits the carrier phase and code measurements along
with the reference station information (that is, location) to the Rover
station modem.

The frequency range of the modem depends on the country in which
the receiver is used: for North America, the frequency range is 410-
470; for all other countries, contact your local distributor.

The HiPer XT is compatible with Pacific Crest radio
modems.

GSM Module

GSM modems function similarly to a standard cell phone, where one
modem (at the Rover) calls another (at the Base). If your receivers are
configured with GSM capabilities, a phone number and service plan
are required. Contact your Topcon dealer for details.

ANYTHING ELSE??

The GSM module internally connects to and controls through the
UHF modem board.

Power Board

The internal power board manages receiver power and battery
charging, and is connected to the receiver board and the batteries. The
power board receives power from the internal batteries, even when the
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receiver is turned off. This feature allows the internal batteries to
charge, regardless of the receiver’s status (on or off). To prevent the
batteries from discharging when the receiver is stored, put the receiver
in Zero Power Mode (see ‘“Zero Power Mode” on page 4-19 for more
information). The batteries will not charge in this mode.

The power board’s processor and firmware are independent of the
receiver card. To ensure firmware compatibility, the GPS receiver
board and power board must be loaded with firmware from the same
package.

GPS+ Receiver Board

The receiver is supplied with a Euro-112T card capable of processing
the following signals:

* GPSL1or GPS L1/L2
* GPS/GLONASS L1 or GPS/GLONASS L1/L.2

Table 1-1 lists the options available for these cards.

Table 1-1. Euro Card Options for HiPer XT

Euro Card Model Available Options

Euro-112T (HGGDT) G: GPS L1

GD: GPS L1/L2

GG: GPS/GLONASS L1
GGD: GPS/GLONASS L1/L2

A WAAS-enabled TPS receiver allows simultaneous tracking of two
WAAS satellites. Each of the WAAS satellites is allocated its own
channel.

Battery

The receiver is equipped with two non-removable, on-board,
rechargeable Lithium-Ion battery packs connected to the receiver’s
power board. Each one of these Lithium-Ion battery packs is 7.4 V
and 4 Ah, giving you a total power of 7.4 V, nominal, and 8 Ah when
fully charged.

1-12 HiPer XT Operator's Manual




Getting Acquainted

Table 1-2 describes the operating times for the HiPer XT receiver,
with the internal batteries fully charged and dependent on the mode of
the modem.

Table 1-2. Operating Times

Modem Mode Base Rover
TX mode ON (2W) 11 hours --
TX mode ON (1W) 7? --

RX mode ON - 14 hours

OFF 16 hours 16 hours

The Li-Ion batteries used in the HiPer XT should run at no less than
98% capacity after 500 charging cycles. These batteries do not need
to be drained before recharging.

A battery charger (AC adapter) is included with the standard package.
See Appendix A for technical specifications on the battery.

External Components

The HiPer XT casing includes panels for radio antenna attachment, a
user interface, a power port, and ports for configuration.

Bottom Panel

The bottom panel of the HiPer XT receiver has the receiver serial
number, receiver part number, receiver type (Base or Rover), and
antenna reference point (ARP).

Radome
Figure 1-4 on page 1-14 shows the radome components:

¢ Internal antenna — Location of GPS/GLONASS internal antenna.

¢ Modem antenna connector — Modem antenna connector used for
internal modem RF connection. This is a BNC female connector
for UHF modems.
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Figure 1-4. HiPer XT Radome

Front Panel

Figure 1-5 on page 1-15 shows front panel components for the HiPer
XT receiver:

e MINTER - The Minimum INTERface for the receiver consisting
of three keys and four, three-color LEDs. See “Using the
MINTER” on page 4-2 for descriptions and usages of the
MINTER components.

» Reset — This key performs a hard reset for both the receiver board
and the power board. Once this key is pressed, the controllers
governing the receiver and power boards reboot and the device
restarts.

* This key can be used to leave Zero Power Mode or if the receiver
does not respond to commands. See “Using the MINTER” on
page 4-2 for more information.

* Four serial ports:

— Port A used for communication between the receiver and a
controller or any other external device.

— Port B used internally to connect the receiver board and
Bluetooth module.
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— Port C used internally to connect the modem and receiver
boards.

— Port D used for communication between the receiver and an
external device.

* USB — used for high-speed data transfer and communication
between the receiver and an external device.

* PWR - The power input port to which an external power source
(+6 to +28 V DC) is connected and where the unit is charged.

e Slant height measure mark (SHMM).
MINTER

Slant Height Measure Mark

Figure 1-5. HiPer XT Front Panel
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Back Panel
Figure 1-6 shows back panel components for the HiPer XT.

* Vent plug — Equalizes the pressure between the inside of the
receiver and the outside environment.

* Slant height measure mark (SHMM)

Vent Plug

HiPer XT

Slant Height Measure Mark

Figure 1-6. HiPer XT Back Panel

Option Authorization File (OAF)

Topcon Positioning Systems issues an Option Authorization File
(OAF) to enable the specific options that customers purchase. An
Option Authorization File allows customers to customize and
configure the receiver according to particular needs, thus only
purchasing those options needed.

Typically, all receivers ship with a temporary OAF that allows it to be
used for a predetermined period of time. When the receiver is
purchased, a new OAF permanently activates desired, purchased
options. Receiver options remain intact when clearing the NVRAM or
resetting the receiver.

The OAF enables the following kinds of functions. For a complete list
of available options and details, visit the TPS website
(www.topcongps.com/tech/index) or consult your TPS dealer.

* Type of signal (standard L1; optional L2)
* Memory (standard OMB; optional 1MB to 128MB)
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» Update rate standard 1Hz (optional 5, 10, or 20Hz)
RTK at 1Hz, 5SHz, 10Hz, and 20Hz
RTCM/CMR Input/Output

* Event marker

* Co-Op tracking

* Advanced multipath reduction

* Wide Area Augmentation System (WAAS)

* Receiver Autonomous Integrity Monitoring (RAIM)

1 PPS (Pulse-Per-Second; a timing signal)
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Notes:
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Chapter 2

Configuration

This chapter describes:
* Receiver’s power supply
* Connecting the receiver and a computer
* Configuring the receiver
* Minimum INTERface (MINTER) configuration
» Radio configuration
* Bluetooth module configuration
* Collecting almanacs
Before you can begin using the HiPer XT receiver, do the following:

1. Charge the batteries. See “Powering the Receiver” on page 2-2.
2. Configure the various parts of your receiver. See:

* “Connecting the Receiver and a Computer” on page 2-10,
» “Receiver Configuration” on page 2-15,

* “MINTER Configuration” on page 2-18,

» “Radio Configuration” on page 2-25, and

* “Bluetooth Module Configuration” on page 2-43.

3. Collect an almanac. See “Collecting Almanacs” on page 2-48.
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Powering the Receiver

You can power the receiver using the internal batteries, using an

external battery, or a battery charger.

Internal Batteries

With a full charge, and depending on the mode of the radio modem,
the internal batteries should power the GPS receiver and the radio
modem according to the times listed in Table 2-1.

Table 2-1. Operating Times

Modem Mode Base Rover
TX mode ON (2W) 11 hours --
TX mode ON (1W) 7 -

RX mode ON -- 14 hours

OFF 16 hours 16 hours

1. To charge the internal batteries:

* Plug the receiver-to-SAE power cable into the receiver’s

power input port.

» Connect the receiver-to-SAE power cable and the power
supply-to-outlet cable to the AC adapter.

* Plug the power supply-to-outlet cable into an available outlet.

2. Press the Reset key on the receiver. This will ensure that the
receiver is in Normal mode for charging. The receiver will not
charge in Zero Power Mode (for details, see “Zero Power Mode”

on page 4-19).

3. Leave overnight. An approximately seven-hour charge cycle will
charge the batteries about 90%. An approximately nine-hour
charge cycle will fully charge the receiver. The internal batteries

can not be overcharged.
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The speed of the charge depends on the Power and Charger settings
on the Receiver Configuration screen, and whether the receiver is
turned off or on. See “Power Management” on page 2-5 for more
information.

The Li-Ion batteries used in the receiver should run at no less than
98% capacity after 500 charging cycles. These batteries do not need
to be drained before recharging.

External Batteries

In addition to the internal batteries, you can use your receiver with
external batteries (Figure 2-1 on page 2-4). External batteries allows
you to continue using the receiver in case the internal batteries are
discharged and requires the following:

* a 12V, 2.3 A*h battery
* a2.3 A*h battery clip-to-SAE cable
* an SAE-to-Power Plug cable

@ NOTICE

When the receiver uses external batteries, set the charger
mode to Off. Otherwise, the external batteries will also
charge the internal batteries, causing operation time to
decrease. See “Power Management” on page 2-5 for more
information on setting the charger mode.

1. Connect the SAE ends of the battery clip-to-SAE and the SAE-to-
power plug cables.

2. Plug the power cable into the receiver’s power port.
3. Attach the battery clip to the battery.
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A single external 12 V, 2.3 A*h battery should run the receiver for
about 7 hours and the receiver and modem for 5 hours.

Figure 2-1. External Battery Attached to Receiver

You can also use an SAE-to-SAE extension cable and an
Alligator clip-to-SAE cable, and power the receiver from a
battery, such as the battery used to power your Base radio
or similar battery.

Battery Charger

The same charger used to charge the internal batteries can be used as
an external power supply for the receiver. The charger is provided
with the receiver package.

1.

2.
3.
4

Connect the receiver-to-SAE cable to the receiver’s power port.
Connect the SAE end of the cable to the battery charger.
Plug the battery charger’s power cable into the AC adapter.

Plug the power cable into an available, grounded outlet. The
power input for your battery charger should be AC between 90
and 264 V 1A (110 V AC) and between 47 Hz and 63 Hz. The
battery charger outputs DC 12 V 2.5 A (30 W).
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Turning On/Off the Receiver

To turn ON the receiver, press and hold the green power key for about
0.5 seconds and release it.

@ NOTICE

If the receiver does not turn on, it may be in Zero Power
Mode. See “Zero Power Mode” on page 4-19 for more
information.

To turn OFF the receiver, press and hold the green power key for
more than one and less than four seconds (until both the STAT and the
REC LEDs are off). This delay (about 1 second) will prevent the
receiver from being turned off by mistake.

Power Management

You can use Topcon’s PC-CDU software to manage your receiver’s
power. The complete description of PC-CDU exceeds the scope of
this manual, but can be found in the PC-CDU User’s Manual. The
latest copy of this software and the manual can be downloaded from
the TPS website.

To access the dialog box controlling the power settings for the
receiver, take the following steps:

1. Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-10 for this procedure.

Once connected, click Configuration » Receiver.

3. Select the Power Mode drop-down list to set the desired power
source (Figure 2-2 on page 2-6). Current Mode displays the
current power source.

* Auto - receiver automatically selects the power source

* Mix — receiver automatically detects and consumes power
from the source with the largest voltage

* Battery A — receiver consumes power from battery A

* Battery B — receiver consumes power from battery B
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» External — receiver uses an external power supply
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Figure 2-2. Select Power Mode

4. Select the Charger Mode drop-down list to set the desired charger
mode (Figure 2-3). Current Mode displays the charging battery:
a, b, or none (off).

* Off — receiver will not charge batteries
» Charge A — receiver charges only battery A
» Charge B — receiver charges only battery B

* Auto — receiver automatically detects and charges both
batteries
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Figure 2-3. Select Charger Mode
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5. Select the Power output modes Ports drop-down list to set power
output on the serial ports (Figure 2-4).

* On — the power board will deliver voltage on pin one of all
serial port connectors when the receiver is turned on. If the
receiver is turned off, there will be no power on any ports.

» Off — power will be absent even if the receiver is on.

* Always — the power board will deliver voltage on pin one of
all serial port connectors even if the receiver is turned off.

6. Select the Power output modes Slots drop-down list to set power
output on internal slots (Figure 2-4).

* On - all slots are powered if the receiver is turned on

» Off — internal slots will not be powered even if the receiver is
turned on

* Always — internal slots will be powered even if the receiver is

turned off
*
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kvl bk [dacy el P'r.‘;"'*""""""""' rE— |
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e hawgs Rt
- st O Siatus :1 Mode ks
Baner:
Temperatun [Crbas dogoea} - =Rl
B irmpeesiae | || Cussert Mods ©
Fowver putput modey Tiam onsolt Sioty
Foits! i - g 5";
Skt
Shott: o0 2] || & s
o
_ felmh |

Power output mode:
Parts : On

Ok |G | Save | Ser ol pssmetess o datauki |

Slats :

Figure 2-4. Select Power Output Modes — Ports and Slots
7. View the Voltages information (Figure 2-5 on page 2-8).
» External — displays the external power supply’s voltage
* On Board — displays the voltage drawn by the receiver board

» Battery A — displays the voltage of battery A
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* Battery B — displays the voltage of battery B
» Charger — displays the charger’s output voltage during battery

charging
[ rrceiver Connguration = xif| Woltages [voltsl——
Grosnk | WINTER | Postinrg | Base | Rover | Pute | Events | Adverced| 7 Estermnal - |12_1
Ehervalion musk: [chegrane| .'M o i‘{»ﬂl!l )
Totrinal Elervlicn: Mack [ o — | E"::: e On Board : I?.B
?ym [Frterea o oo o)~ cumriblode: [ || ompod: [75 Battery b : I?.B4
[Rme Cument Input i
e Chasges I
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Figure 2-5. View Voltages Information
8. Select and check each of the Turn on/off Slots check boxes to
enable the corresponding internal slots (Figure 2-6).

9. Select and check the Enable Low Power Mode check box to put
the receiver’s processor into low power consumption mode
(Figure 2-6).
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= Alfo Ea OC Slmu:i it Meds . . B | ,’:
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Helsh H [
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Figure 2-6. Enable and Apply Power Settings
10. Click Apply.
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Charging Internal Batteries

Use one of the following conditions for maximum battery charge
speed:

* The receiver is turned off. Power Mode and Charger Mode are set
to Auto. See “Power Management” on page 2-5 for setting these
parameters.

¢ The receiver is turned on. Power Mode is set to External and
Charger Mode is set to Auto.

1. To charge the internal batteries:

* Plug the receiver-to-SAE power cable into the receiver’s
power input port.

* Connect the receiver-to-SAE power cable and the power
supply-to-outlet cable to the AC adapter.

* Plug the power supply-to-outlet cable into an available outlet.

2. Press the Reset key on the receiver. This will ensure that the
receiver is in Normal mode for charging. The receiver will not
charge in Zero Power Mode (see “Zero Power Mode” on page 4-
19 for more information).

3. Leave overnight. A seven-hour charge will charge the batteries
about 90%. A nine-hour charge will fully charge the receiver. The
internal batteries cannot be overcharged.

When finished charging, set the Power Mode to Auto.

@ NOTICE

If you remove a power supply cable before setting Power
Mode to Auto, the receiver will be turned off. To turn it on,
you will need to connect an external power supply once
again.
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Checking Internal Battery Status

To check the status of the internal batteries:

1. Check the BATT LED for battery status.
* A green light indicates greater than 85% charge.
* An orange light indicates an intermediate charge.

* A red light indicates less than 15% charge.
2. Do one of the following:

* Click on Configuration » Receiver to view battery voltages
on the Receiver Configuration screen.

* Click on Help » About to view battery voltages on the About
PC-CDU screen.

Connecting the Receiver and a
Computer

To configure, manage files, or maintain the receiver, connect the
receiver and a computer, and start PC-CDU:

* use a Bluetooth-enabled external device (computer)

¢ use an RS232 cable

* use a USB cable and a computer with the TPS USB driver
installed (available at http://www.topcongps.com/software/
updates.html)

Once you have established a connection between the receiver and the
computer (whether through Bluetooth wireless technology, the RS232
cable, or the USB cable), you will be able to:

* configure the receiver and its components
* send commands to the receiver
* download files from the receiver’s memory

* load new firmware using FLoader™, OAFs, and configuration
files to a receiver
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Establishing a Wireless Connection

The HiPer XT receiver contains Bluetooth wireless technology that
allows file transfer and synchronization between the receiver and any
other external device that supports Bluetooth wireless technology; for
example, an iPAQ, or a computer with USB-to-Bluetooth adapter or
PCMCA-to-Bluetooth adapter installed.

@ NOTICE

Changing the receiver’s Port B default settings will affect
the Bluetooth link. The default settings for Port B are:
115200 bps, 8 data bits, 1 stop bit, no parity, and no
handshaking.

The receiver and external device connection procedure varies slightly
depending on the type of external device used. In general, the
connection procedure is as follows:

@ NOTICE

Refer to your Bluetooth-enabled external device
documentation for detailed connection information.

1. Turn on a Bluetooth-enabled external device and the receiver. The
default external device mode is Master; the receiver’s Bluetooth
module mode is Slave.

2. Instruct the external device (Master) to search for the receiver
(Slave).

3. Once the Master device detects the receiver, use the procedure
described in the external device’s documentation to connect it
with the receiver.

4. Once connected, continue with Step 1 in “Establishing a PC-
CDU Connection” on page 2-13.
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If you cannot establish a connection, check that the receiver’s slot
three is enabled.

1.

Connect your receiver and a computer using an RS232 cable or
USB cable and PC-CDU as seen below.

Click Configuration » Receiver » General.

In the Turn on/off Slots area, ensure the Slot 3 (B) check box is
enabled.

Establishing an RS232 Cable

Connection

1. Using the RS232 cable, connect the serial port of your computer
(usually COM1) to the receiver’s serial port A.

2. Press the power buttons on the receiver and computer to turn
them on.

3. Continue with Step 1 in “Establishing a PC-CDU Connection” on

page 2-13.

Establishing a USB Connection
Make sure the computer has the TPS USB driver installed.

1.

Using the USB cable, connect the USB port of your computer to
the receiver’s USB port.

Press the power buttons on the receiver and computer to turn
them on.

Continue with Step 1 in “Establishing a PC-CDU Connection” on
page 2-13.
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Establishing a PC-CDU Connection

PC-CDU is a Personal Computer-Control Display Unit software used
to manage the various functions of your receiver. The full range of
PC-CDU configuration and function is outside the scope of this
manual. For more information on any of the procedures in this section
or on PC-CDU, refer to the PC-CDU User’s Manual available on the

TPS website.

1. Once the receiver and a computer are connected, start PC-CDU
on your computer. The PC-CDU main screen displays
(Figure 2-7).

RIS EY
File Configuration Tools Flaks Help

GPS Satellites Geo |%vz | Taget| GLONASS Satellites
# [ EL[ azfcalpire] 7o 5] tgﬁ] sn|Fn [ EL] az[calmi[pr2] 1c] 55

At

el

FMS Pos:
RMS Vel
FDOP:

Receiver time:
Receiver date:
Clock offset:
Osc. offset :
Tracking time:

|Discornected

Figure 2-7. PC-CDU Main Screen
Notice that the lower-left hand corner shows the receiver status as
“Disconnected”.
Click File » Connect.
3. On the Connection Parameters dialog box, select the following
parameters and click Connect:
* for Bluetooth or RS232 connections (Figure 2-8 on
page 2-14):
— Set the Connection mode (Direct).

— Set the port for your computer (typically COM1, COM2
for RS232 connection and COM3, COM4, etc. for
Bluetooth connection) from the Port drop-down list.
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— Set the communication rate between the receiver and the
computer (usually 115200) from the Baud rate drop-

down list.

x
Connecti

’V(:' Dlr _______ " Internet Client " Internet Server ‘

—Port zetting:

Port: IEDM‘I 'l Baud rate: |1152DD 'l [~ Infrared part

[~ RTS/CTS handshaking

—Program setting:
[~ Passivermode [~ Manual mode only

[~ Restore the receiver's onginal baud rate on Disconnect

Internet setting

Hist riame: |Iocalhost TIER port: IBDDD

Fazsword: I

I~ | Dizplay data on server, | Log servernevents [~ DHS lookup
Connect I Cancel |
Figure 2-8. Bluetooth and RS232 Connection Parameters

* for USB connections (Figure 2-9):

— Set the Connection mode (Direct).

— Set the port for your computer (USB) from the Port drop-
down list.

— Select the receiver’s ID from the Rec ID drop-down list.

Eﬂtonnection Parameters ﬂ
C ioh mode
’V " Internet Client " Internet Server ‘

—Port zetting:

Port: IUSB VI Fec [D: ISPAZKEB41 [&"%) vl I~ | Infrared port

—Program setting:

[~ Passivemode [~ | Manualmode anly Timeout [ms]: ISDD vl

™| Restore the receivers original baud rate on Disconnest

—Internet [ Client - Server | setting

Hist riame: |Iocalhost TIER port: IBDDD

Fazsword: I

I~ | Dizplay data on server, | Log servernevents [~ DHS lookup

Connect I Cancel |

Figure 2-9. USB Connection Parameters
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Once a PC-CDU connection with the receiver has been established,
the current communications settings—such as, port name, baud rate
(if applicable), and flow control (if applicable)—display in the lower-
left corner of the main window of PC-CDU. A timer begins to count
up in the lower-right corner as well (Figure 2-10).

il
File Configuration Tools Plots  Help

GPS Satellites [D) Geo |><YZ | Talgetl GLOMNASS Satellites [0)
# | EL] azfcalpi]pre] 1o 5] tg:] Sn|Fnl EL[ eaz[calmi[pr2] 7] 55

Al

Vel

RMS Pos:
RMS Vel
FDOP:

Feceiver time: 08:06:07
Receiver date: 24.09 2002
Clock offset:

Osc. offset

Tracking time: 00:00:00

coM2, 115200 I 00:00:12

Figure 2-10. PC-CDU Connection Established

Receiver Configuration

PC-CDU configures the various parts of the receiver, saving the
settings in the receiver’s memory, and will be reflected when you use
the MINTER. The full range of PC-CDU configuration and function
is outside the scope of this manual.

\
TIP

Refer to the PC-CDU User's Manual to manage all possible
receiver configurations.

The following configuration is recommended for the most common
applications. However, you can select configuration parameters as
needed for your particular jobsite.

@ NOTICE

Click Apply after making any configuration change,
otherwise your receiver will not accept the change.
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1. Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-10 for this procedure.

Once connected, click Configuration » Receiver (Figure 2-11).
3. Click the MINTER tab, configure the following settings, and
click Apply (Figure 2-11).
 Set the Recording interval in seconds.

* Set the Elevation mask for Log file in degrees.

* Enter the File name prefix. Use the last three digits of the
receiver serial number.The receiver’s serial number and part
number can be found on the bottom panel of the receiver.

Configuration
T x
- TER il
Target position CtrbeT | Pasiioning | Base | Rover | Parts | Events| Advanced |
Radio ¥ | nterval 100 [seconds] FN key mode
Covaon mesk frLogfs:  [5 | (degrees] [F LED biink made switch Occupation mods switch
IFiIe name prefis o Initia] dats collection dynamic mod
o appee to th fls IV(-‘ Statir: . Kinematic
Files Cgjon mods Diata recording auto-star
[F Logfie  AFAM | [F off  0On  Always
Automatic Fils RotatioNJode [8FAM] parameters——
Period [sec]; [3600 [totl]: [0
L ID
Fecording interval : 1.00 [zeconds]
Elevation maszk for Log file : |1 5 [degrees)
File name prefix : log Retesh | ot |

[ ok | st Save | Set all parameters ta defauits |

[
Figure 2-11. Receiver Configuration — MINTER Tab

If your jobsite is in an area that has obstructions (buildings, trees,
etc.), and/or the antenna location is near reflective objects,
configure the receiver to reduce errors from these sources.

), WARNING

[WARNI

Do not make other changes without consulting the
PC-CDU User’s Manual.
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4. Click the Advanced tab then the Multipath Reduction tab,
enable the following boxes, and click Apply (Figure 2-12).

* Code multipath reduction
* Carrier multipath reduction

£ Receiver Confiqueation x|
Girnmal | MINTER | Postineg| fase | Ao | Pots | Evends Scvanced |

Enrlnrsdeverace. Mfuhnmm|. Je ] | e |
o Conte ity imhiactam
7 [t et sk clior]

Speet e |

Ok |G | Seve | Senslpmsmetse o detis |

Figure 2-12. Receiver Configuration — Advanced Tab

5. Click the Loop Management tab, enable the following boxes,
and click Apply (Figure 2-13).

* Enable Co-Op tracking
* Static Mode

o
Gl | MINTER | Postineg | Bace | Ao | Pots | Evends Scvanced |
| b |e | | s |
i Emmr Erain Co0p hockng
3 7 [Siniic Mo
FLL aridr: — T
Budcded koo bandwidth
el Harabwdth o cosnon FLL =0 Hel
[:/4 ends quaded loop honchvicér |27 Mzl
¥ Enable Auagivve Gundend 7 Enatle Conmmen Leop o L2
v Enable Co-Op tracking—
| Ais, |
=3
Ok | G | Save | Ger sl pssmetse o detius |

Figure 2-13. Advanced Configuration — Loop Management

6. Click OK to close the Receiver Configuration dialog box.

7. Click File » Disconnect, then File » Exit to quit PC-CDU.
Disconnecting before exiting ensures proper port management.
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@ NOTICE

Disconnecting the receiver from the computer before
exiting will eliminate any possible conflict in the
management of your serial ports.

Once the receiver is configured, the configuration will remain until
you change it either using PC-CDU or clearing the NVRAM.

MINTER Configuration

The Minimum INTERface (MINTER) consists of three keys (Power,
FN, and Reset) and four LEDs (STAT, REC, BATT, and RX) that
control and display the receiver’s operation (Figure 2-14).

Power Button Reset BATT
(battery LED)

STAT (status LED)

REC (recording LED) RX

LED
FN (function/recording button) (modem status )

Figure 2-14. MINTER
The MINTER performs numerous functions:

* Turn the receiver on or off, put it in either Sleep mode or Zero
power mode.

* Turn data recording on or off (FN key).
* Change the receiver’s information mode.

* Show the number of GPS (green) satellites being tracked (STAT
led).
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Show data recording status (REC led).
Show each time data is recorded to internal memory (REC led).

Show the status of post-processing mode (static or dynamic)
when performing a Post-Processing Kinematic survey with the
help of FN key (REC LED).

Show the status (high charge, intermediate charge, or low charge)
of the battery (BATT LED).

Show the power source for the receiver (BATT LED).

Show the status of the modem and if it receives signals (RX
LED).

Use PC-CDU to configure MINTER settings. Refer to the PC-CDU
User’s Manual for other possible MINTER configurations.

1.

Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-10 for this procedure.
On the Connection Parameters dialog box, enable RTS/CTS
handshaking (Figure 2-15).

ﬁtunnecliun Parameters

Connection mode
|7(3' Direct € Intemet Client € Intemnet Server |

—Port setting:

Port: [COM1 | Baud rate: [115200 | ™ Infrarsd port

W RTS/CTS handshaking l

Program setting; /

[ Passivemode [ Aanua\ mode only  Timeout [ms]: | 500 =
. original baud rate on Disconnect
[¥ RTS/CTS handshaking |
I
L= e TR port: 5000

Fassyord I

I~ Displap dataonsever [ Logserver events: I~ BKS lookup:

Cancel
Figure 2-15. Connection Parameters — MINTER Settings

Click Configuration » Receiver then click the MINTER tab, set
the following parameters and click Apply (Figure 2-16 on

page 2-20). See the following pages for descriptions of these
parameters:

* Recording interval on page 2-20
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Elevation mask for log file on page 2-20

File name prefix on page 2-21

Always append to the file on page 2-21

e Files Creation mode on page 2-21

* Automatic File Rotation Mode (AFRM) on page 2-21
* FN key mode on page 2-23

e [nitial data collection dynamic mode on page 2-23

* Data recording auto-start on page 2-23

[d receiver Configuration x|

General MINTER | Positoning | Base | Flover | Ports | Events | Advanced |

Recording interval 1.00 (seconds] "FN kep mode

Elewation mask for Log file 5 (degiess) & LED blink mode switch ¢~ Occupation mode switch
File name prefe: log Iritial data collection dynamic madk
Always append to the file (“‘ Shatic ¢ Kiremetic

Files Creation mode Data recording auto-start
[ﬁ Log file " AFRM ‘ ’7(? 0ff © 0On  Always

[~Automatic File Rotation Mode ([AFRM] parameters

Period [sec] : | 3600 Files (tatal ] 0
PFhase [sec] |0 Files (remair] f 1

I= Automaticall remoye old fies

Refiesh | Appy |

Exit Save | Setall parameters to defaults
I

Figure 2-16. Receiver Configuration — MINTER Tab

Recording Interval parameter

This parameter specifies the message output interval into the log
file when the MINTER FN key (pressed for 1-5 seconds)
activates data logging. This setting is used for both logging a
single log file, and logging receiver data in AFRM mode. Values
are 1-86400 seconds.

The default value is one second.

Elevation Mask for Log File parameter

This parameter specifies the minimum elevation angle for the
satellites whose data will be put in the receiver files logged when
pressing FN.

The default value is five degrees.
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File Name Prefix parameter

This parameter specifies the prefix added to the names of receiver
files created when pressing FN. The prefix can be up to 20
characters long.

The default value for the Name Prefix is “log”.

Log file names have the following structure:

<prefix><month><day><sequential alphabet letter>

The file name depends on both the file creation time (month and
day) and additional letter suffixes to avoid confusion between
files created on the same day.

Always Append to the File parameter

If you want new receiver data to be appended to an existing log
file, enter the desired file name in this parameter. The setting can
be up to 20 characters long.

Files Creation Mode parameter

This parameter has two possible operation modes:

* Log file — If the log file radio button has been selected,
pressing the FN key closes the current log file. If data logging
is off, pressing FN opens a new log file.

* AFRM - If AFRM radio button has been selected, pressing
FN enables this mode. If AFRM has been enabled, pressing
FN disables this mode.

Automatic File Rotation Mode (AFRM) parameters

TPS receivers are capable of automatically rotating log files.
During a “file rotation” event, the receiver closes the current file
and opens a new one according to a user-defined schedule. The
Period and Phase parameters specify this schedule. File rotation
launches the moment the receiver time module Period is equal to
Phase. More precisely, a new log file opens immediately before
the scheduled epoch causing data tagged with this epoch to be
recorded to the new log file.

When opening a new log file, the receiver enables the default set
of messages outputted with the default output period. Both the
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default set of messages and the default output period are
programmable.

* Period — specifies the time duration of each log file created in
AFRM mode.

Values are 60 to 86400 seconds; default value is 3600 seconds.

» Phase — specifies the “phase” (constant time shift) of creating
multiple log files in AFRM mode.

Values are 0 to 86400 seconds; default value is zero seconds.

* Files (total) — a counter that specifies how many multiple log files
must be created in AFRM until this mode automatically turns off.
This counter decrements on every file rotation until it value
becomes zero, then file rotation automatically stops. The counter
initializes with AFRM.

Note that a log file opens immediately after turning AFRM on.
This startup file is not considered a file rotation event; the AFRM
counter will not decrement.

Values are 0 to [231—1]; default value is O (zero). Zero means that
an unlimited number of log files will be created.

@ NOTICE

The receiver's memory holds up to 512 files.

* Files (remain) — specifies the number of files left for the receiver
to create in AFRM.

Values are 0 to [231—1]; default value is zero.

* Automatically remove old files — when no free memory is
available to log data, automatically removes the earliest log file. If
this parameter is enabled, your receiver will erase the file with the
earliest file creation time/date. AFRM must be enabled to use this
FIFO (First-In, First-Out) feature.

The default value is off (disabled).
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FN Key Mode parameter

Use these two radio buttons to program how the receiver will
react when pressing the FN key.

* LED blink mode switch — pressing FN will toggle between
the MINTER’s normal/extended information modes and start/
stop data recording of Static survey.

— FN pressed for less than 1 second: changes the
information mode (Normal or Extended Information (EI)
Modes).

— FN pressed for 1 to 5 seconds: starts or stops data
recording (Static post-processing mode).

* Occupation mode switch — pressing FN (less than one
second) will insert into the corresponding log file a message
indicating that the survey type has been changed from static
to kinematic, or vice versa. If the REC LED blinks green, the
current mode is dynamic, if it blinks orange, the current mode
is static. For more details, see Table 4-1 on page 4-5 and refer
to the MINTER User’s Manual and PC-CDU User’s Manual.

Initial Data Collection Dynamic Mode parameter

These radio buttons specify the starting occupation type
descriptor inserted at the beginning of receiver files logged.
Select Static or Kinematic to specify that the corresponding log
file will start with a static (STOP) or kinematic (GO, Trajectory)
occupation, respectively.

Data Recording Auto-start parameter

These radio buttons allow you to program your receiver’s
behavior in the event of a power failure.

Table 2-2 on page 2-24 gives the different scenarios available and
the results after power is restored to the receiver. “Specified file”
refers to the file name entered in the Always append to file
parameter.
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Table 2-2. Data Recording Parameter Behavior

Before Enabled Radio Button Results
Power
Failure Off On Always
1 Data logging will | Receiver will Receiver will
Receiver data | not resume when resume data resume data logging
logged to file | power is restored. | logging to the to the same file
specified. same file when when power is
power is restored. | restored.
2 Data logging will Anew logfilewill | A new log file will
Receiver data | not resume when open when power | open when power is
logged to power is restored. | is restored and restored and data
default file. data will log to will log to this file.
this file.
3 No file will open No file will open A log file with this
Filespecified; | with this name. with this name. name will open and
receiver data Data logging will | Data logging will | data logging will

logging not

not start when

not start when

start after power is

started. power is restored. | power is restored. | restored.

4 Data logging will Data logging will | A log file with a
No file not start when not start when default name will
specified; power is restored. | power is restored. | open and data
receiver data logging will start
logging off. after power is

restored.

Also, if Always is enabled, your receiver will automatically start
logging data (to a newly created or an existing file) in the
following three cases:

* After turning on the receiver using the Power key.

* After resetting the receiver (using PC-CDU or pressing the
Reset key).

* After taking the receiver out of Sleep Mode.
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Radio Configuration

Modem-TPS is Topcon’s radio modem configuration utility for
modems embedded in HiPer family receivers. Modem-TPS provides
the following functions:

* Connecting a PC to an integrated radio modem via a serial port or
Bluetooth wireless technology.

* Displaying information about the radio modem installed in the
receiver.

* Programming the radio modem’s settings.

See the following sections for details on configuring the HiPer XT
with UHF or GSM radio modem using Modem-TPS.

Topcon’s configuration and surveying software, TopSURY, also has
the ability to configure HiPer receivers. Refer to the TopSURV
Reference Manual or TopSURV User’s Manual for details.

\
TIP

Use TopSURYV for convenient in-field configuration.

@ NOTICE

Note that the UHF radio and the GSM radio do not work
simultaneously. Only one radio may be used at a time.

Installing Modem-TPS
Modem-TPS is available from the TPS website or the GPS+ CD.

e If downloading the program from the website, extract the
program files into a folder on your hard drive.

* If installing the program from the GPS+ CD, insert the CD into
the computer’s CD-ROM drive.

Computer requirements for Modem-TPS are: Windows® 98 or newer
and an RS-232C or USB port. Use Modem-TPS version 1.7 or newer
to correctly configure the receiver.
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1. Navigate to the location of the Modem-TPS program and double-
click the Setup.exe icon.

2. Keep the default installation location or select a new location.
Click Finish.

Modem-TPS Installation

Please enter the directary in which to install
Modem-TPS.

Installing Files...

Extracting file to C:\Pragram Files\Madem-TPS 4wt dll

todem-TPS Directary:

C:A\Program Files\odem-TPS Change

Finish F\l Cancel ‘

Figure 2-17. Select Modem-TPS Installation Location and Install

3. Click OK to complete the installation.

4. If desired, create a shortcut on the computer’s desktop for quick
access to Modem-TPS (Figure 2-18).

Modem-TPS Installation

Modem-TPS installation successhull

AIDEM

MEEEG-TTS
Figure 2-18. Installation Complete and Shortcut

To uninstall Modem-TPS, use the Start menu on your computer:

Click Start » Programs » Modem-TPS » Uninstall Modem-
TPS, and click Yes at the prompt. Then click OK when the
uninstall completes.
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Configuring a Base Station’s UHF
Radio Modem

@ NOTICE

To comply with RF exposure requirements, maintain at
least 25cm between the user and the radio modem.

For HiPer XT receivers, the integrated TPS UHF radio modem
provides TX/RX UHF communications between a Base Station and
Rover. To configure the UHF radio modems, have the following
ready:

* Computer running Windows® 98 or newer
* Modem-TPS ver 1.7 or newer
* Serial cable (or Bluetooth wireless technology capabilities)

1. Connect the computer and receiver using an RS232 cable or
Bluetooth wireless technology.
Turn on the receiver.

3. Open Modem-TPS and select the COM port the receiver is
connected to (Figure 2-19).

4. Click Connect.

@ L]

[ Connection ... ‘X\

Port's setting

COM1 hd
Cancel

Disconnected

Figure 2-19. Connect to Modem-TPS
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When finished configuring the radio modem, always disconnect from
Modem-TPS before exiting to prevent conflicts with serial port
management.

There are two scenarios for configuring the radio-modem:
* with a dedicated channel
 with the FCS mode

Set Radio Link Parameters for a Dedicated
Channel

1. From the Protocol control, select between TPS and PDL.

* TPS — Select this protocol if all of the radio-modems at your
jobsite are manufactured by Topcon Positioning Systems.

* PDL — Select this protocol if you use PDL radio-modem(s)
together with TPS radio-modem(s) at the jobsite.

2. From the Modulation Type control, select a modulation scheme
that will be used by your base radio-modem. It can be either 4-
Level-FSK (Frequency Shift Keying) or GMSK (Gaussian
Minimum Shift Keying). The following table shows you what
modulation technique can be used at a specific link rate.

If the Link Rate is... Use...
4800 baud GMSK
9600 baud GMSK or 4-Level-FSK
19200 baud 4-Level-FSK

3. From the Link Rate control, select the rate at which data is
transmitted over the RF link. The UHF radio-modem supports
4800, 9600, and 19200 baud. Note that this setting affects the
Modulation Type control and vice versa.

4. From the TX control, select the operating frequency that will be
used by your base radio-modem to transmit differential data.

5. Select Scrambling. If enabled, this parameter provides more
robust data communications over the areas with possible
interference.
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6. For a maximum data communication reliability, select the
Forward Error Correction checkbox. With this parameter
enabled, the rover radio-modem has the capability to check and
correct transmission errors (if any) in an incoming data stream.

@ NOTICE

While providing error control in data transmission, FEC
adds redundant check bits to the data stream reducing
data throughput. If you are going to use FEC and a format
of differential messages requires a great deal of data (e.g.,
RTCM 2.x) transmitted over the radio link, it is
recommended to select 19200@4-Level-FSK. This will
ensure reliable radio communication between the base
and rover receivers.

7. From the Protocol Mode control, select the appropriate link
protocol among the following available:

* Transparent w/EOT Character
* Transparent w/EOT Timeout

* Fast Async

8. If you select Transparent w/EOT Character, the EOT
Character (Dec) field will be displayed. In this field enter a
decimal value (usually a control character). Once the specified
character is found in the incoming data stream, the modem begins
data transmission.

If you select Transparent w/EOT Timeout, the TX ACK
Timeout (in x10 ms) field will be displayed. In this field enter an
integer value between 1 (corresponds to 10 ms) and 50
(corresponds to 500 ms). Once the timeout between incoming
data exceeds the specified value, the modem begins data
transmission.
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9. From the Output Power control, select the level of RF transmit
power from 10 mW to 2 W.

.
[z UHF Modem 460 MHz - [O]x]
Fie Tods Help

Radio Link |FCS | GSM | Serial Interface | Identification |

Apply |

Protocol [ PS5 =] T [4A0.0000 MHz =]
Modulation Type: [ 4-Level FSK (=] R [ 464.5500 mhz =]

Link Rate 19200 - Scrambling: I

Forward Error Correction: ¥

Protocol Mode: | Transparent w/ECT Character =
EOT Character (Dec): |10
Qutput power: 1w =

Exit |

comt, 115200 | 260133

Figure 2-20. Radio Link Tab

10. Click the Serial Interface tab and select a baud rate for the
modem’s serial port. The same rate must be used for both the
receiver and the modem.

FZ{UHF Modem 460 MHz e S |

Fle Tools Help

Radin Link | FCS | GSM  Seril Interface |Idemiﬁcatmm |

pimply

Baud rate port: 38400 =

Exit |

comt, 115200 | 26:04.36

Figure 2-21. Serial Interface Tab
11. Click Apply, then click on File and select Disconnect. If you
want to close the program, click File->Exit.

12. Launch PC-CDU and set up the receiver to run as an RTK Base
Station. For how to set up an RTK Base using PC-CDU, refere to
your receiver’s documentation or PC-CDU User’s Manual.
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Set Radio Link Parameters for Free Channel
Scan

1.
2.

From the Protocol control, select TPS.

From the Modulation Type control, select a modulation scheme
that will be used by your base radio-modem. It can be either 4-
Level-FSK (Frequency Shift Keying) or GMSK (Gaussian
Minimum Shift Keying). The following table shows you what
modulation technique can be used at a specific link rate.

If the Link Rate is... Use...
4800 baud GMSK
9600 baud GMSK or 4-Level-FSK
19200 baud 4-Level-FSK

From the Link Rate control, select the rate at which data is
transmitted over the RF link. The UHF radio-modem supports
4800, 9600, and 19200 baud. Note that this setting affects the
Modulation Type control and vice versa.

Select Scrambling. If enabled, this parameter provides more
robust data communications over the areas with possible
interference.

For a maximum data communication reliability, select the
Forward Error Correction checkbox. With this parameter
enabled, the rover radio-modem has the capability to check and
correct transmission errors (if any) in an incoming data stream.

@ NOTICE

While providing error control in data transmission, FEC
adds redundant check bits to the data stream reducing
data throughput. If using FEC and a format of differential
messages requires a great deal of data (e.g., RTCM 2.x)
fransmitted over the radio link, it is recommended to select
19200@4-L evel-FSK. This will ensure reliable radio
communication between the base and rover receivers.
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10.
11.

From the Protocol Mode control, select the appropriate link
protocol among the following available:

* Transparent w/EOT Character
* Transparent w/EOT Timeout
* Fast Async

If you select Transparent w/EOT Character, the EOT
Character (Dec) field will display. In this field enter a decimal
value (usually a control character). Once the specified character is
found in the incoming data stream, the modem begins data
transmission.

If you select Transparent w/EOT Timeout, the TX ACK
Timeout (in x10 ms) field will display. In this field enter an
integer value between 1 (10 ms) and 50 (500 ms). Once the
timeout between incoming data exceeds the specified value, the
modem begins data transmission.

From the Output Power control, select the level of RF transmit
power from 10 mW to 2 W.

Click on the FCS tab.

From the Mode control, select Master.

In the Free Scan Frequency List control, you will see the
frequencies that are used in the scan process. Double-click a
frequeny in the list to exclude/include this frequency from/to the

scan process. You may also select/deselect all frequencies at one
time with the Select all and Deselect all controls.

@ NOTICE

12.

For FCS to operate properly, you must select at least two
frequencies.

In the Time Out edit box, enter the number of seconds that a base
radio modem will send a service word to the rover radio modem.

@ NOTICE

Set the Time out larger (by 2, 3 seconds) than the period of
transmitting differential corrections.
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13. In the Noise Level field, specify a threshold value for the noise
level.

* High — sets the noise level to -70 dBm. Recommended in
noisy environments.

¢ Medium — sets the noise leve to -85dBm. Recommended in
most environments.

¢ Low — sets the noise level to -100 dBm. Recommended in
low-noise environments.

The base radio-modem regularly scans the current operating
frequency to determine the degree of a radio noise/interference on
this frequency. Should the level of noise on the given operating
frequency be greater than the level specified in this field, the
transmitter will take the following measures:

* Stops broadcasting on this frequency

* Switches to the next frequency in the list and performs the
scan on this new frequency.

— If the frequency is clear of noise, the radio-modem will
start using this frequency for data transmission.

— Otherwise, the radio-modem will continue the scan
process throughout the frequency list until the frequency
with an acceptable amount of noise is found.

FZ UHF Modem 460 MHz o |
File Tools Help
Radio Link FCE | GSM | Serial Interface | Identification |
; Apply
Free Scan Freguency List:
Made: [ Master 'I
¥ 450.0000 kHz
7 470.0000 MHz Time Out: [3
¥ 4538875 MHz
« 461.0000 MHz Moige Level: | Medium 'l
¥ 4587500 MHz
¥ 4537000 MHz
 464.5500 MHz
7 450.1375 WHz Bellel el
- Deselect all
Exit |
comi, 115200 || 0:10:32|

Figure 2-22. FCS Tab
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14. Click the Serial Interface tab and select a baud rate for the
modem’s serial port. The same rate must be used for both the
receiver and the modem.

15. Click Apply, then click on File and select Disconnect. If you
want to close the program, click File » Exit.

16. Launch PC-CDU and set up the receiver to run as an RTK Base
Station. For how to set up an RTK Base using PC-CDU, refere to
your receiver’s documentation or PC-CDU User’s Manual.

Configuring a Rover Station’s UHF
Radio Modem

@ NOTICE

To comply with RF exposure requirements, maintain at
least 25cm between the user and the TPS UHF radio
modem.

Repeat steps 1-4 from page 2-27.

When finished configuring the radio modem, always disconnect from
Modem-TPS before exiting to prevent conflicts with serial port
management.

There are two scenarios for configuring the radio-modem:
* With a dedicated channel.
* With the FCS mode.

Set Radio Link Parameters for a Dedicated
Channel

1. From the Protocol control, select between TPS and PDL.

* TPS — Select this protocol if all of the radio-modems at your
jobsite are manufactured by Topcon Positioning Systems.

e PDL - Select this protocol if you use PDL radio-modem(s)
together with TPS radio-modem(s) at the jobsite.
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2. From the Modulation Type control, select a modulation scheme
that will be used by your rover radio-modem. It can be either 4-
Level-FSK (Frequency Shift Keying) or GMSK (Gaussian
Minimum Shift Keying). The following table shows you what
modulation technique can be used at a specific link rate.

If the Link Rate is... Use...
4800 baud GMSK
9600 baud GMSK or 4-Level-FSK
19200 baud 4-Level-FSK

Must be the same for base and rover.

3. From the Link Rate control, select the rate at which data is
transmitted over the RF link. The UHF radio-modem supports
4800, 9600, and 19200 baud. Note that this setting affects the
Modulation Type control and vice versa. Must be the same for
base and rover.

4. From the RX control, select the operating frequency that will be
used by your rover radio-modem to receive differential data. Must
be the same for the base and rover.

5. Select Scrambling. If enabled, this parameter provides more
robust data communications over the areas with possible
interference. Must be the same for base and rover.

6. For a maximum data communication reliability, select the
Forward Error Correction checkbox. With this parameter
enabled, the rover radio-modem has the capability to check and
correct transmission errors (if any) in an incoming data stream.
Must be the same for base and rover.

@ NOTICE

While providing error control in data transmission, FEC
adds redundant check bits to the data stream reducing
data throughput. If you are going to use FEC and a format
of differential messages requires a great deal of data (e.g.,
RTCM 2.x) transmitted over the radio link, it is
recommended to select 19200@4-Level-FSK. This will
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10.

11.

ensure reliable radio communication between the base
and rover receivers.

From the Protocol Mode control, select the appropriate link
protocol among the following available:

* Transparent w/EOT Character

* Transparent w/EOT Timeout

* Fast Async
Use the same protocol as at the base station.
From the Output Power control, set the level of RF transmit
power to 10 mW.

|
[z UHF Modem 460 MHz - [O]x]
Fie Tods Help

Radio Link |ch | &M | Serial interface | 1gentification |

Apply |

Pratocal: | TPS =] T [450.0000 mHz =]
Modulation Type: [ 4-LevelFSK =] Ret [480 0000 MHz =]

Link Rate: 19200 ) Scrambling: #

Forward Errar Correction: M

Protocol Mode: | Transparent w/EQT Character x
EQT Character (Dec): |10

Qutput power: 10 mwy =

Exit |

oM, 115200 | 250755

Figure 2-23. Radio Link Tab

Click the Serial Interface tab and select a baud rate for the
modem’s serial port. The same rate must be used for both the
receiver and the modem.

Click Apply, then click on File and select Disconnect. If you
want to close the program, click File » Exit.

Launch PC-CDU and set up the receiver to run as an RTK Rover
Station. For how to set up an RTK Rover using PC-CDU, refere
to your receiver’s documentation or PC-CDU User’s Manual.
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Set Radio Link Parameters for Free Channel
Scan

1.
2.

From the Protocol control, select TPS.

From the Modulation Type control, select a modulation scheme
that will be used by your rover radio-modem. It can be either 4-
Level-FSK (Frequency Shift Keying) or GMSK (Gaussian
Minimum Shift Keying). The following table shows you what
modulation technique can be used at a specific link rate.

If the Link Rate is... Use...
4800 baud GMSK
9600 baud GMSK or 4-Level-FSK
19200 baud 4-Level-FSK

Must be the same for base and rover.

From the Link Rate control, select the rate at which data is
transmitted over the RF link. The UHF radio-modem supports
4800, 9600, and 19200 baud. Note that this setting affects the
Modulation Type control and vice versa.

Select Scrambling. If enabled, this parameter provides more
robust data communications over the areas with possible
interference. Must be the same for base and rover.

For a maximum data communication reliability, select the
Forward Error Correction checkbox. With this parameter
enabled, the rover radio-modem has the capability to check and
correct transmission errors (if any) in an incoming data stream.
Must be the same for base and rover.

@ NOTICE

While providing error control in data transmission, FEC
adds redundant check bits to the data stream reducing
data throughput. If you are going to use FEC and a format
of differential messages requires a great deal of data (e.g.,
RTCM 2.x) transmitted over the radio link, it is
recommended to select 19200@4-Level-FSK. This will
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10.
11.
12.

ensure reliable radio communication between the base
and rover receivers.

From the Protocol Mode control, select the appropriate link
protocol among the following available:

* Transparent w/EOT Character
* Transparent w/EOT Timeout

* Fast Async
Use the same protocol as at the base station.

If you select Transparent w/EOT Character, the EOT
Character (Dec) field will be displayed. In this field enter a
decimal value (usually a control character). Once the specified
character is found in the incoming data stream, the modem begins
data transmission.

If you select Transparent w/EOT Timeout, the TX ACK
Timeout (in x10 ms) field will be displayed. In this field enter an
integer value between 1 (10 ms) and 50 (500 ms). Once the
timeout between incoming data exceeds the specified value, the
modem begins data transmission.

From the Output Power control, set the level of RF transmit
power to 10 mW.

Click on the FCS tab.
From the Mode control, select Slave.

In the Free Scan Frequency List control, you will see the
frequencies that are used in the scan process. Double-click a
frequeny in the list to exclude/include this frequency from/to the
scan process. You may also select/deselect all frequencies at one
time with the Select all and Deselect all controls.

@ NOTICE

For FCS to operate properly, you must select at least two
frequencies. Also the selected frequencies must be the
same as at the base radio-modem.
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13. In the Time Out edit box, specify a period of time in seconds
within which the rover radio-modem will listen to the incoming
data on the current operating frequency. Should there be no any
data detected during the specified amount of time, the rover will
switch to the next frequency in the list and so forth until the
frequency with data is found.

@ NOTICE

It is recommended to make this parameter greater than the
base radio-modem’s Time out by 2 to 3 seconds.

[ZAUHF Modem 460 MHz !EIE!
File Tools Help
Radio Link FCE | GSM | Serial Interface | Identification |
Apply
Free Scan Frequency List
+ 450.0000 MHz [ -] Mode: | Slave =
« 450.0000 MHz
 470.0000 MHz Time Out: |5
« 458.8875 MHz
< 451.0000 MHz Maise Level: {1000

v 458 7500 MHz

v 458 7000 MHz
v 464 5500 MHz

4501375 MHz Select all
E Deselect all

comt, 115200 | B.47:18

Exit |

Figure 2-24. FCS Tab

14. Click the Serial Interface tab and select a baud rate for the
modem’s serial port. The same rate must be used for both the
receiver and the modem.

15. Click Apply, then click on File and select Disconnect. If you
want to close the program, click File » Exit.

Launch PC-CDU and set up the receiver to run as an RTK Rover
Station. For how to set up an RTK Rover using PC-CDU, refere to
your receiver’s documentation or the PC-CDU User’s Manual.
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Configuring a Base Station’s GSM
Module with Modem-TPS

@ NOTICE

To comply with RF exposure requirements, maintain at
least 25cm between the user and the GSM radio modem.

1. Repeat steps 1-4 from page page 2-27.
When finished configuring the GSM module, always disconnect
from Modem-TPS before exiting to prevent conflicts with serial
port management.
Click the GSM tab.

3. In the Mode control, select Slave.

4. In the PIN field, enter a Personal Identification Number (PIN) if
required.

5. For the base station, leave the Dial field blank.

6. Inthe Send time field, enter a period of time in seconds with
which the base GSM modem will send a service word to the rover
GSM modem. This parameter is used to maintain reliable
communication between the pair of modems and avoid
unnecessary modem reinitialization.

@ NOTICE

To ensure reliable and secure modem communication, this
parameter must be larger then the period of transmitting
diferential corrections.

If both of your receivers are HiPer XT with internal GSM
modems, set Send time to zero.
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|
[z UHF Modem 460 MHz - [O]x]
Fie Tods Help

Radio Link | FCE  GEM |Ser|a| Interface | Identification |

Apply
Ilade: IT;I
PN [1234
Dial l—
Send time lZ—

Exit |

comt, 115200 | 26:10:50

Figure 2-25. GSM Tab

7. Click the Serial Interface tab and select a baud rate for the
modem’s serial port. The same rate must be used for both the
receiver and the modem.

8. Click Apply, then click on File and select Disconnect. If you
want to close the program, click File->Exit.

9. Launch PC-CDU and set up the receiver to run as an RTK Base
Station. For how to set up an RTK Base using PC-CDU, refere to
your receiver’s documentation or PC-CDU User’s Manual.

Configuring a Rover Station’s GSM
Module with Modem-TPS

@ NOTICE

To comply with RF exposure requirements, maintain at
least 25cm between the user and the GSM radio modem.

1. Repeat steps 1-4 from page 2-27.

When finished configuring the GSM module, always disconnect
from Modem-TPS before exiting to prevent conflicts with serial
port management.

Click the GSM tab.
3. In the Mode control, select Master.
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4. Inthe PIN field, enter a Personal Identification Number (PIN) if
required.

5. In the Dial field, enter the phone number of the base GSM
modem.

6. Inthe Send time field, enter a period of time in seconds with
which the rover GSM modem will send a service word to the base
GSM modem. This parameter is used to maintain reliable
communication between the pair of modems and avoid
unnecessary modem reinitialization.

@ NOTICE

If both of your receivers are HiPer XT with internal GSM
modems, set Send time to zero.

|
[z UHF Modem 460 MHz - [O]x]
Fie Tods Help

Radio Link | FCS  GEM |Ser|a| Interface | Identification |

Apply
Ilade: IW;I
PN 1234
Dial o200ees
Send time lZ—

Exit |

comt, 115200 | 26:11:55

Figure 2-26. GSM Tab

7. Click the Serial Interface tab and select a baud rate for the
modem’s serial port. The same rate must be used for both the
receiver and the modem.

8. Click Apply, then click on File and select Disconnect. If you
want to close the program, click File->Exit.

9. Launch PC-CDU and set up the receiver to run as an RTK Rover
Station. For how to set up an RTK Rover using PC-CDU, refer to
your receiver’s documentation or the PC-CDU User’s Manual.
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Bluetooth Module
Configuration

Use BTCONEF, Topcon’s Bluetooth module’s configuration program,
and your computer to:

* access the Bluetooth wireless technology module
* configure the Bluetooth module
* check or change the module’s configuration

To access the Bluetooth wireless technology module, first download
and install BTCONEF, then connect your computer and the receiver
and run the configuration program.

1. Create or locate the following folder:

C:\Program Files\TPS\BTCONF
2. Download btconf.zip from the TPS website and unzip it into the

BTCONTEF folder. This file contains Btconf.exe, the executable file
for the Bluetooth module configuration program.

Each time you run BTCONF and configure the Bluetooth module,
BTCONTF saves your settings in a file (btconf.ini). BTCONF
automatically updates the file each time you make changes to the
Bluetooth module’s settings.

To maintain unique Bluetooth module settings for different
purposes, keep copies of BTCONF in separate folders.

To uninstall BTCONE, delete any applicable BTCONEF directories or
folders, and any BTCONF shortcuts.

Once you have BTCONF available, follow these steps to configure
the Bluetooth module.

1. Using the RS232 cable, connect the serial port of your computer
(usually COM1) to the receiver’s serial port A. If needed, turn on
the receiver and computer.
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2. Run the Bluetooth module configuration program (Btconf.exe)
(Figure 2-27).

BTCONF = 3

IEDM‘I 'l Identification | Parametersl Serial Interfacel

Bluetoath Information:

About ;I

Connect

Appli

M

Disconnect

I]

Exit

|Disc:0nnec:ted |

Figure 2-27. Bluetooth Module Configuration Main Screen

Notice that the lower left corner shows a “Disconnected’ status
for the computer and Bluetooth module.

For BTCONF version and copyright information, click the About
button.

3. From the drop-down list in the upper left corner, select the
computer serial port (usually COM1) used for communication
(Figure 2-28 on page 2-44).

4. Click Connect to connect the computer and Bluetooth module
(Figure 2-28).

BTCONF 1 1
Com1 |  Identification | Parametersl Serial Interfacel

Bluetoath Information:

About ;I

Connect

Appli

Disconnect

I

=
|

Exit

|Disc:0nnec:ted

Figure 2-28. Select Communication Port and Click Connect
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Once the receiver and computer connect through BTCONF, the
Identification tab (Figure 2-29) displays the following
information:

¢ Bluetooth name — the name of the Bluetooth module, set in
the Parameters tab.

* Bluetooth address — the unique electronic address for your
Bluetooth module.

¢ Firmware version — the current firmware version of the
Bluetooth module.

1
BTCONF 1 1
Com1 | Identification | Parametersl Serial Interfacel

Bluetoath Information:
Bluetoath name: TopconPS ;I

Bluetooth address: 0015 B210 00CE 0010
Firmware version: BCO2%1.2 12-20-2002

About

Connect

Appli

Disconnect

HARIN

K

Exit

[Eom1, 115200 |

Figure 2-29. BTCONF Identification Tab

The COM port and baud rate display in the lower left corner.

5. Click the Parameters tab (Figure 2-30). The Parameters tab sets
identifying and security information for your Bluetooth module.
The security section allows you to set data security and
unauthorized access parameters for the Bluetooth module.
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6. Enter up to 14 characters to set a unique name for the Bluetooth
module (Figure 2-30), and click Apply.

BTCONF I [
I COM1 i l |dentification

About | Bluetooth Mame: ITopconF’S

Security
Connect |
Blugtaath PIN: |
Apply %l
Encrpption: [
Disconnect |
Suthertication: [

Exit |

[Eom1, 115200 |

Figure 2-30. BTCONF Parameters Tab

7. To set security parameters (Figure 2-31 on page 2-47), enter and
enable the following, then click Apply:

* Bluetooth PIN — enter up to 16 characters to specify a
personal identification number for the Bluetooth module.

* Encryption — enable to have the Bluetooth module encrypt
wirelessly sent data. To read encrypted data, the user must
have the same PIN used in the device that sent the data.

* Authentication — enable to require a PIN before two
Bluetooth enabled devices (such as, the receiver and a
computer) can establish a communication link. The two
devices must use the same PIN.

@ NOTICE

If you do not need security settings, leave these
parameters disabled.
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BTCONF = 3

ICDM'I 'l Idertification Parameters | Senial Interfacel
About | Bluetooth Mame: ITopconF’S

Security
Connect |
Blugtaath PIN: [ 123456789
Apply %l
Encryption: v
Disconnect |
Authentication: v

Exit |

[EOm1, 115200

Figure 2-31. BTCONF Security Parameters

8. Click the Serial Interface tab (Figure 2-32). Enable Echo to
display Bluetooth module replies and corresponding commands
on the computer terminal. If needed, click Apply.

BTCONF [ofxl|

IEDM‘I 'l Identificationl Parameters

About Eche: ™

Connect

Appli

Disconnect

L

Exit

[Eom1, 115200 |

Figure 2-32. BTCONF Serial Interface Tab
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9. Click Disconnect then Exit (Figure 2-33) to quit BTCONF.

BTCONF = 3

IEDM‘I 'l Identification | Parametersl Serial Interfacel
Bluetoath Information:
About | Bluetoath name: TopconPS A|
1
El BTCONF (O[]
Carnect | |
IEDM‘I 'l Identification | Parametersl Serial Interfacel

Bluetoath Information:

About ;I

Connect

_ oo
| G |
|
[Shsianesi]

COM1, 115200 Aeply

Disconnect

|Disc:0nnec:ted |

Figure 2-33. Click Disconnect then Exit

Collecting Almanacs

Each satellite broadcasts a message (almanac) which gives the
approximate orbit for itself and all other satellites. If the receiver has
an almanac, you can considerably reduce the time needed to search
for and lock on to satellite signals.

The receiver regularly updates the almanac and stores the most recent
almanac in its Non-Volatile Random Access Memory (NVRAM).

1. Set up the receiver (connect the external antenna, if needed) in a
location with a clear view of the sky.
Turn on the receiver.

3.  Wait for about 15 minutes while the receiver collects almanac
data from the satellites.

@ NOTICE

If 15 minutes have passed and the receiver does not lock
on to satellites, you may need to clear the NVRAM. See
“Clearing the NVRAM” on page 4-17 for this procedure.
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You will need to collect or update the almanac under the following
circumstances:

* If the receiver has been off for a long time.

If the last known receiver position, stored in the NVRAM, is
different from the present position by several hundred kilometers.

* After loading a new OAF.
* After loading new firmware.
* After clearing the NVRAM.

* Before surveying.
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Chapter 3

Setup and Survey

This chapter describes:
* Receiver setup
* RTK Base station setup
* RTK Rover setup
* Basic surveying with the HiPer XT receiver

The HiPer XT package use one receiver as the Base station and the
other as the Rover station.

Receiver Setup

@ NOTICE

Note that the UHF radio and the GSM radio do not work
simultaneously. Only one radio may be used at a time.

To set up the receivers, you must:

1. Configure the receivers as shown in Chapter 2.

2. Set up the Base and Rover stations. See “Step 1: Set up the
Receiver” on page 3-2.

3. Measure the antenna height. See “Step 2: Measure Antenna
Height” on page 3-2 for internal antennas.

4. Begin collecting data. See “Step 3: Collect Data” on page 3-4.

All receivers include an internal, micro-strip antenna able to capture
L1/L2 signals from GPS and GLONASS satellites.
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Step 1: Set up the Receiver

This section assumes the receiver has already been configured.

1. Place the receiver on the appropriate tripod or bipod.

2. Center the receiver over the point at which data will be collected.
For most applications, this should be at a location with a clear
view of the sky.

Step 2: Measure Antenna Height

The location of the antenna relative to the point being measured is
very important for both surveys in which the elevation of the points is
important and in surveys for horizontal location only. Horizontal
surveys are often larger in area than can reliably fit on a flat plane,
therefore the antenna adjustment must be done in three dimensions
and then projected onto a two dimensional plane.

The receiver calculates the coordinates of the antenna’s phase center.
To determine the coordinates of the station marker, the user must
specify the following:

* Measured height of the antenna above the station marker
* Method of measuring the antenna height
* Model of the antenna used

Antennas have two types of measurements:

¢ Vertical — measured from the marker to the antenna reference
point (ARP) located on the bottom of the receiver at the base of
the mounting threads.

* Slant — measured from the marker to the lower edge of the
antenna slant height measure mark (SHMM) located on both end
panels of the receiver.

1. Measure the antenna height above the point or marker.

Figure 3-1 illustrates the antenna offsets. (See Figure 1-5 on
page 1-15 and Figure 1-6 on page 1-16 for the exact SHMM
location.)
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7y '
30.50mm SHMM I
y

77.75mm |

Figure 3-1. HiPer XT Antenna Offsets
¢ SHMM to ARP vertical offset = 30.50mm

* SHMM to ARP horizontal offset = 77.75mm
Table 3-1gives the offset values for the receivers.

Table 3-1. Antenna Offset Values for Receiver Options

To L1 Phase Center To L2 Phase Center

Up

105.9mm 97.1mm

The point to which surveying with GPS/GLONASS measures is
called the Phase Center of the antenna. This is analogous to the
point at which a distance meter measures in a prism. A user must
enter the prism offset to compensate for this point not being at a
physical surface of the prism. In the case of a GPS/GLONASS
antenna, the offset is entered depending on the type of
measurement taken. For vertical, the offset is simply added to the
measured vertical height to produce a “true” vertical height. For
slant height, the vertical height must first be calculated using the
radius of the antenna, then the offset can be added. The offsets are
not the same number because of the difference in location
between the slant measuring point and the vertical measuring
point.

Record the antenna height, point name, and start time in the field
notes.
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Press the power key and release it to turn the receiver on. The
STAT (status) light (LED) will blink red at first.

Once the receiver has locked on to one or more satellites, the
STAT light will blink green for GPS satellites, orange for
GLONASS satellites, and a short red blink indicating it has not
solved a position. Four or more satellites provide optimal
positioning.

Once the short red blink is gone, the receiver has a position and
surveying can begin. You should wait for green and orange lights
before beginning data collection. This ensures that the receiver
has the correct date and time, and is locked on to enough satellites
to ensure good quality data.

The process of locking on to satellites normally takes less than
one minute. In a new area, under heavy tree canopy, or after
resetting the receiver, it may take several minutes.

Step 3: Collect Data

1.

To begin collecting data, press and hold the FN (function) key for
more than one second and less than five seconds.

Release the FN key when the REC (recording) LED light turns
green. This indicates that a file has opened and data collection has
started. The REC LED blinks each time data is saved to the
internal memory.

Use PC-CDU to configure data logging. See “MINTER
Configuration” on page 2-18 or refer to the PC-CDU User’s
Manual.

When finished, press and hold the FN key until the REC LED
light goes out.

To turn off the receiver, press and hold the power key until all
lights go out, then release.

3-4 HiPer XT Operator's Manual



Surveying with the Receiver

Surveying with the Receiver

The receiver can be used to perform Static, Kinemati, and Real-time
kinematic (RTK) surveying.

@ NOTICE

To comply with RF exposure requirements, maintain at
least 25cm between the user and the radio modem.

Static Survey

Static surveying is the classic survey method, well suited for all kinds
of baselines (short, medium, long). At least two receiver antennas,
plumbed over survey marks, simultaneously collect raw data at each
end of a baseline during a certain period of time. These two receivers
track four or more common satellites, have a common data logging
rate (5-30 seconds), and the same elevation mask angles. The length
of the observation sessions can vary from a few minutes to several
hours. The optimal observation session length depends on the
surveyor’s experience as well as the following factors:

* The length of the baseline measured

* The number of satellites in view

* The satellite geometry (DOP)

* The antenna’s location

* The ionospheric activity level

* The types of receivers used

* The accuracy requirements

* The necessity of resolving carrier phase ambiguities

Generally, single-frequency receivers are used for baselines whose
lengths do not exceed 15 kilometers (9.32 miles). For baselines of 15
kilometers or greater, use dual-frequency receivers.

Dual-frequency receivers have two major benefits. First, dual-
frequency receivers can estimate and remove almost all ionospheric
effect from the code and carrier phase measurements, providing much
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greater accuracy than single-frequency receivers over long baselines
or during ionospheric storms. Secondly, dual-frequency receivers
need far less observation time to reach the desired accuracy

requirement.

After the survey completes, data the receivers collect can be
downloaded onto a computer and processed using post-processing
software (for example, Topcon Tools).

The procedure that follows describes the steps the operator should
take to perform a Static Survey using MINTER.

1. Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-10 for this procedure.
2. Open PC-CDU, click Configuration » Receiver » MINTER

and specify the following parameters, then click Apply
(Figure 3-2):

* Recording interval — 15 seconds

» Elevation mask angle — 15 degrees

* File name prefix — last 3 digits of receiver serial number

* LED blink mode switch — enable to start and stop static data
recording using the FN key

Ei Receiver Configueation

Ganesd MINTER | Postonrg | Sace | Hove | Pute | Eventz | Advarcsd |

4 Uesgnalon mode svatch

Pleccadeq nerval: [156 frecondil FH ke mode

Ebwnionmack luLogBls:  [5 Wegrest] % LED Link. mods swich

Fim e g [lea il data cobection dynamic mods
T | = 2
Fies Comation made Drata recording sutu-slad

F Logiis  oFRM & C On

FAutumate: Fie Rolalon Mods PFRM| paasetes

Fecording interval

Elesation mask for

File name prefix :

: 1.00 [zeconds]

Log file : |1 5 [degrees]

log

x|

Hehesh

FHkeymode———
& LED blirk mode switch

oy |

OF. I Lt Save Gualnuumuilndefml

Figure 3-2. Configure MINTER
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3. Click the Advanced tab and then the Multipath tab, set the
following parameters, then click Apply (Figure 3-3):

* Code multipath reduction — enable

* Carrier multipath reduction — enable

£ Receiver Confiqueation
Girnmal | MINTER | Postineg | Bace | Ao | Pote | Everls Scanced |

Enrlnrsdeverace. wnm|. Je ] | e |

¥ Coxde st eccton
[t nediguadh rechacler]

¥ Code multipath reduction

Speet e |

Ok |G | Save | Ser sl psmetess o datauti |

Figure 3-3. Configure Multipath

4. Click the Loop Management tab and set the following parameters,
then click Apply (Figure 3-4):

* Enable Co-Op tracking — enable

e Static mode — enable

£ Receiver Confiqueation
Girnmal | MINTER | Postineg | Bace | Ao | Pote | Everls Scanced |

I b C | | 3ptms |
PLL banduidh =0 g | [ Frbie Co 1 hackng
FLL crcer; 3 1 [Sinic: Mode - .
Rtdcled oo handidth 05 e IR
Harabmdh of comnen FLL 0 Hzl
[:/4 ends quaded loop honchvicér |27 el
7 Enable fulagive Gued Loops 7 Enable Conmn Loop o L2

¥ Erabls P11 and P2 hacking

Ok |G | Save | Ser sl psmetess o datauti |

Figure 3-4. Configure Loop Management

5. Setup each antenna and receiver as described in “Receiver
Setup” on page 3-1.
6. Begin surveying.
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Kinematic (Stop and Go) Survey

In a kinematic, stop and go survey, the stationary receiver (Base
station) is set up at a known point such as a survey monument, or an
unknown point. The receiver continually tracks satellites and logs raw
data into its memory. The rover receiver is set up at an unknown point
and collects data in static mode for 2 to 10 minutes. When finished,
assign the Rover to kinematic status and move to the next survey
point. At this point, and each subsequent point, the receiver is
changed to static mode to collect data. So, while moving, the Rover is
in kinematic mode, and while collecting data, the Rover is in static
mode.

1. Using PC-CDU, configure and set up the Base as described in
“Static Survey” on page 3-5.

2. Click Configuration » Receiver » MINTER, configure the
Rover with the these parameters, and click Apply (Figure 3-5):

e FN key mode, Occupation mode switch — enable
e Initial data collection dynamic mode, Kinematic — enable
See Table 4-1 on page 4-5 for FN key functions and REC LED

statuses.
o

Ganesd MINTER | Postonrg | Sace | Hove | Pute | Eventz | Advarcsd |

Puecsrdeg rterval: 100 fsecondi] FH ity o

Elwationmack I LogBle: [ Kemeei]  LED birk. ke smtch | % Uscupaton muods swich

File ruswiom sl I Iral data collection dynanft- mode

Abvirys opysoesd | lims Kl © S & Kremalic

Fies Comation made Drata recording sutu-slad

 Logte  AERM & on oo oy
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Figure 3-5. Rover MINTER Configuration

@ NOTICE

Remember, both Base and Rover receivers must collect
data from the same satellites, at the same data recording
rate, and with identical elevation mask angles.
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3. Setup the Rover at an unknown point and press power. Allow the
Rover to collect static data for two to ten minutes. The REC LED
will be orange.

4. Check the STAT light for satellites tracked.

5. When finished, press the FN key for less than a second to assign
the Rover to kinematic.

Remember, if the REC LED blinks green, the current mode
is dynamic, if it blinks orange, the current mode is static.

6. Move the Rover to the next location (survey point), and press the
FN key for less than a second to collect the data in static mode for
two to ten minutes.

7. Repeat steps five and six until all points have been surveyed. The
occupation time for the points depends on the same factors as for
the static survey method.

8.  When finished, press the FN key for one to five seconds to stop
logging data. Turn off the Rover if needed.

This method of GPS survey allows the operator to reduce the point
occupation time, thus permitting field crews to survey many more
points compared to the other methods available.

Real-time Kinematic Survey

Real-time kinematic (RTK) is a differential GPS process where
information, such as differential corrections, is transmitted in real-
time from a Base station to one or more Rover stations.

Set up an RTK Base Station

To configure an RTK Base station using PC-CDU, take the following
steps:

1. Set up the Base station receiver’s antenna as described in
“Receiver Setup” on page 3-1.

2. Press the power key on the receiver.
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3. Check the STAT light for tracked satellites.

4. Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-10 for this procedure.

5. Click Configuration » Receiver.
6. Click Set all parameters to defaults (Figure 3-6).

G receiver Connguratian = x|
Grosnk | WINTER | Postinrg | Base | Rover | Pute | Events | Adverced|
i ke | - Power “Votages [yt
Trtrand Elervalion Mask: 5 i s =] || Extenats [
E— -eterrs Stans (rmad ool — Cunetbode: [ || OnBomd: [0
Coiend | (et [
 Eximnal Chasgss | Reey: [TE4
& Ao Est OC Status: [/ Mods: T | =
i o | Bamey i |72
Temperahun [Colsus degesat e =1 i
Fit rermre st I Cumentt Mads: :me: fres
| ~Fiowver nulpul modes 1~ Tuam onvolt Slots—
Pty [“ - - Skt 2
= 7 5ked
Set all parameterto defaults Shet - on 2] | | sk
| 7 Engble Low Power Mode
Heliesh J Ay
I sml wu%«ml

Figure 3-6. Set All Parameters to Defaults

7. On the Receiver Configuration screen, click the MINTER tab and
specify the desired settings. Refer to the PC-CDU User’s Manual
for more information.

8. Click the Positioning tab and set the Elevation mask parameter to
15 (Figure 3-7), then click Apply.

o
Gienmal | MINTER [PESi00n § e | Hoves | Pt | Evenls | Advarsed|
¥ Starsisionn |5 Standsinn T =
 DGFS [Code Dillweriin] | | 7 0575 ||F Ges [ e I BRI G g
 RTK Fioal B ETH Font e S -
© RIR Femd R R GPS | GLonsss ]| wass|

punlocksn{ puninck|use| pin{inck! ]| pun/lnck| e
iV F WK F &F W

. 0 N v
et ||| (A IFF WFF BFF EFF
k|| | R IFF NFF BFF OFF

= ) i sum; A R o o 1 o i
& Eanl SFF URF AR F 2R F

Elevation mask e Ly EF F UFF ZFF OFF
erdalonn;gs |15 - o IFF BFF 2FF AF F
egree]: {8 S | sF F BFF #F K 2F W
| =] @ ko Conestion Atolock | Nonetaloch]  Altouse | Maorw touse|
DB o | [ T Cenmlon
Filyais N |

Figure 3-7. Configure Receiver Positioning — Elevation Mask
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9. Select the Base tab, set the following parameters (Figure 3-8),
and click Apply:

e GPS/GLO at one time — enable

* Antenna position — enter Lat, Lon, and Alt values. Do one of
the following:

— If known, type in the values.

— Enable Averaged and enter the Averaged Span in seconds,
then click Apply. Click Tools » Reset receiver and wait
until the specified interval (span) completes. Examine the
Base coordinates on the Base tab, they should correspond
to the coordinates obtained from the average. Click
Refresh if the coordinates are zeros.

— Click Get from receiver.

@ NOTICE

The reference geodetic coordinates specified on this tab
relate to the antenna L1 phase center.
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Figure 3-8. Base Configuration
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10. Click the Ports tab and set the following port parameters for the
serial port (Figure 3-9).

* Qutput drop-down list — select type and format of differential
corrections.

Period (sec) — enter interval at which receiver will generate
differential corrections.

Baud rate drop-down list — select a baud rate (i.e., the rate at
which differential messages will be transmitted from receiver
to modem).

RTS/CTS - select to enable handshaking.

Use a 38400 baud rate.

Bl Recuives Conligu ation

Geness | MINTER | Posioning| Tste | fover Puts | Evenis | advances |

Sewal | Paatel| Mudem | USE | Ethenet| TCP | |
oM i Y Baudists- |17 x
Duitgnd | |t ¥ Faind 5] | = 1
Sah | M| Cumen ¥ Baudmie- [11520 ¥
Ourck s [Hene =] Peodrs: [ I~ RTE/TS
; Irgut; | Command = Busdie: 0400 ¥
SeialC
Durget: [CMN * Peniod [1]: || ]  RISAIS
SaislD  fegud . [Command - Bouatoln 115200 =
™ Iohasod  feppus: [Heoe =] Penndfs) | [~ RTS/ATS
L | |
. Input : IEommand 'l Baud rate : |334DD 'l
Serial C
Output: |CMR A Period (2] : |1.UU W RTS/CTS

Figure 3-9. Base Configuration — Ports

11. Click Apply. The receiver begins sending data to the selected
port.

For more details on the settings available for configuring the Base
station, refer to the PC-CDU User’s Manual.
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Set up an RTK Rover

Use the following steps to set up an RTK Rover station. You should
already have programmed the modem.

Figure 3-10 shows the hardware setup for a Rover station with an
external controller.

3
-

v

: b |

Figure 3-10. Rover Station Setup
1. Set up the Rover station receiver’s antenna as described in
“Receiver Setup” on page 3-1.

2. Connect the receiver and computer. See “Connecting the Receiver
and a Computer” on page 2-10.

3. Click Configuration » Receiver.

Click the Positioning tab and set the Position Masks, Elevation
mask (degrees) parameter to 15 (Figure 3-7 on page 3-10).
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5. Click the Rover tab and set the desired Positioning Mode
(Figure 3-11).

Positioning Mode
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Figure 3-11. Rover Configuration
Adjust the following RTK Parameters settings:

¢ Under RTK mode in the RTK Parameters section, choose
either Extrapolation for RTK float (kinematic) or Delay for
RTK fixed (static).

— Extrapolation is for low-latency, high frequency output
(>= 5 Hz) RTK applications. The rover will extrapolate
the base station’s carrier phase measurement corrections
when computing the rover's current RTK position.

— Delay is for 1 Hz high precision RTK applications. The
Rover RTK engine will compute either a delayed RTK
position (for the epoch to which the newly received
RTCM/CMR message corresponds) or the current stand-
alone position (while waiting for new RTCM/CMR
messages coming from the base).

* Select the antenna status during RTK, either Static or
Kinematic.

* Specify the Ambiguity fixing level (not applicable to RTK
Float). The Ambiguity Fixing Level radio buttons govern the
process of the RTK engine, fixing integer ambiguities. The
RTK engine uses the ambiguity fix indicator when making
decisions whether or not to fix ambiguities. Low, Medium,
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and High correspond to the indicator's 95%, 99.5% and
99.9% states, respectively. The higher the specified
confidence level, the longer the integer ambiguity search time

6. Click the Ports tab and set the following parameters for the serial
port (Figure 3-12):

* Input drop-down list — select the desired differential
correction format.

e Period (sec) — leave as is.

* Baud rate drop-down list — select a baud rate (i.e., the rate at
which differential messages will be transmitted from modem
to receiver).

* RTS/CTS - select to enable handshaking.

\
TIP

Use a 38400 baud rate.

Genesst | MINTER | Pesioning | Date | Rover Poss | Events | advenced|
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: Irgad i 3| i[5 5]
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Qg [Nons =] Peiiedrec): I IRTS/CTS
Gaquc  reuti JCMR | Baudrate: |30400 ¥
Ourpet; [Hone =1 Perdliec): I RIS
b | T sl
s | ]
1 o | 1 1
) Input:  |CMA hd Baud rate : |334DD 'l
Serial C
Output : INone 'l Period [sec]:l [~ RTS/CTS
Figure 3-12. Rover Configuration — Ports

Click Apply.
8. Click OK to close the Receiver Configuration dialog box.
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9. On the main screen (Figure 3-13), check the LQ field to ensure
the receiver obtains differential corrections. Usually, the receiver
will start to output the coordinates of the antenna’s phase center
along with the solution type within 10-30 seconds. However,
spread spectrum radios may take as long as 60 seconds to
synchronize.
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Figure 3-13. PC-CDU Main Screen

The geodetic coordinates displayed on the Geo tab are always
computed in WGS84 and have four solution types.

» Standalone — where receiver computes 3D coordinates in
autonomous mode without using differential corrections.

* Code differential — where the Rover receiver computes the current
relative coordinate in differential mode using only pseudo ranges.

* RTK float — where the Rover receiver computes the current
relative coordinates in differential mode using both pseudo ranges
and phases; however, with a float solution, the phase ambiguity is
not a fixed integer number and the “float” estimate is used
instead.

» RTK fixed — where the Rover receiver computes current relative
coordinates, with ambiguity fixing, in differential mode.

The LQ field reflects the status of the received differential messages
and contains the following information:

* Data link quality in percentage

* Time (in seconds) elapsed since the last received message
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* Total number of received correct messages (dependent on the
message type received)

* Total number of received corrupt messages (dependent on the
message type received)

If the receiver is not (for some reason) receiving differential
corrections, or if none of the ports has been configured to receive
differential corrections, the LQ field will either be empty or it will
look like this: 100%(999,0000,0000).
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Notes:
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